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Introduction

Would you like to add powerful and easy-to-use Bluetooth Low Energy to your robot, art or other electronics project? Heck yeah! With BLE now

included in modern smart phones and tablets, its fun to add wireless connectivity. So what you really need is the new Adafruit Bluefruit LE SPI

Friend!

The Bluefruit LE SPI Friend (http://adafru.it/2633) makes it easy to add Bluetooth Low Energy connectivity to anything that supports SPI

communication.  Connect to your Arduino or other microcontroller using the common four-pin SPI interface (MISO, MOSI, SCK and CS/SSEL) plus

a 5th GPIO pin for interrupts (to let the Arduino know when data or a response is ready).

If you like Serial communication more than SPI, we also have a version that can talk UART (http://adafru.it/iCh)
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This multi-function module can do quite a lot! For most people, they'll be very happy to use the standard Nordic UART RX/TX profile. In this profile,

the Bluefruit acts as a data pipe, that can 'transparently' transmit back and forth from your iOS or Android device. You can use our iOS

App (http://adafru.it/iCi) or Android App (http://adafru.it/f4G) to get started sending data from your Arduino to your phone quickly and painlessly.

Why Use Adafruit's Module?

There are plenty of BLE modules out there, with varying quality on the HW design as well as the firmware.  

One of the biggest advantages of the Adafruit Bluefruit LE family is that we wrote all of the firmware running on the devices ourselves from

scratch.

We control every line of code that runs on our modules ... and so we aren't at the mercy of any third party vendors who may or may not be

interested in keeping their code up to date or catering to our customer's needs.

Because we control everything about the product, we add features that are important to our customers, can solve any issues that do come up

without begging any 3rd parties, and we can even change Bluetooth SoCs entirely if the need ever arises!

Technical Specifications

ARM Cortex M0 core running at 16MHz (nRF51822)

256KB flash memory

32KB SRAM

Transport: SPI at 4MHz with HW IRQ (5 pins required)

5V-safe inputs (Arduino Uno friendly, etc.)

On-board 3.3V voltage regulation

Bootloader with support for safe OTA firmware updates

Easy AT command set to get up and running quickly
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Pinouts

Power Pins

VIN: This is the power supply for the module, supply with 3.3-16V power supply input. This will be regulated down to 3.3V to run the chip

GND: The common/GND pin for power and logic

SPI Pins

SCK: This is the serial clock pin, connected to SCK on your Arduino or MCU

MISO: This is the Master In Slave Out SPI pin (nRF51 -> Arduino communication)

MOSI: This is the Master Out Slave In SPI pin (Arduino -> nRF51 communication)

CS: This is the Chip Select SPI pin, which is used to indicate that the SPI device is currently in use.

IRQ: This is the nRF51 -> Arduino 'interrupt' pin that lets the Arduino or MCU know when data is available on the nRF51, indicating that a

new SPI transaction should be initiated by the Arduino/MCU.

Other Pins

DFU: Setting this pin low when you power the device up will force the Bluefruit LE module to enter a special firmware update mode to update

the firmware over the air.  Once the device is powered up, this pin can also be used to perform a factory reset.  Wire the pin to GND for >5s

until the two LEDs start to blink, then release the pin (set it to 5V or logic high) and a factory reset will be performed.

RST: Holding this pin low then releasing it (or wiring it HIGH) will cause a system reset
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Reverse Side Breakouts

On the back we also have a few breakouts!

CLK: This is the SWD clock pin (SWCLK), 3v logic - for advanced hackers!

DIO: This is the SWD data pin (SWDIO), 3v logic - for advanced hackers!

F.RST: This is the factory reset pin. When all else fails and you did something to really weird out your module, tie this pad to ground while

powering up the module and it will factory reset. You should try the DFU reset method first though (see that tutorial page).

3.3V: This is the output from the 3V regulator, for testing and also if you really need regulated 3V, up to 250mA available
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Assembly

Prepare the header strip:

Cut the strip to length if necessary. It will be easier to solder if you insert it into a

breadboard - long pins down

Add the breakout board:

Place the breakout board over the pins so that the short pins poke through the breakout

pads
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And Solder!

Be sure to solder all pins for reliable electrical contact.

Solder the longer power/data strip first

(For tips on soldering, be sure to check out our Guide to Excellent

Soldering (http://adafru.it/aTk)).

You're done! Check your solder joints visually and continue onto the next steps

 

© Adafruit Industries
https://learn.adafruit.com/introducing-the-adafruit-bluefruit-spi-

breakout
Page 14 of 110



Wiring

Default Pinout

In order to follow along with the default tutorial wiring, the Bluefruit LE SPI Friend should be connected to your Uno or Metro board using the

following pins:

Bluefruit LE SPI

Friend

SCK

MISO

MOSI

CS

IRQ

RST (Optional)

VIN

GND

Metro/Uno

13

12

11

8

7

4

5V

GND

We'll be using hardware serial by default, that uses the UNO's hardware pins #13, #12 and #11. You can also use software SPI so you don't have

to locate the hardware SPI pins!

In order for the Bluefruit LE SPI Friend to be 5V-Safe, the VIN pin must be connected to 5V on the Arduino. If you wish to run the board with 3.3V

logic, you can optionally connect VIN to 3.3V, but this should not be done on a 5V Arduino.

Changing the Default Pinout

The examples sketches all assume the above pinouts by default.  If you wish to change the location of the CS, IRQ or RST pins, open

the BluefruitConfig.h file in the example folder, and change the pin to an appropriate value (See the Software section of this

tutorial (http://adafru.it/iCj) for instructions on installing the library):

#define BLUEFRUIT_SPI_CS               8

#define BLUEFRUIT_SPI_IRQ              7

#define BLUEFRUIT_SPI_RST              4

If you want to use software (bitbang) SPI, you can change the SCK, MISO and MOSI pins using the following macros in the same file:
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#define BLUEFRUIT_SPI_SCK              13

#define BLUEFRUIT_SPI_MISO             12

#define BLUEFRUIT_SPI_MOSI             11

The BluefruitConfig.h file can be found in a dedicated tab, as shown below:

For all the example code, we have at the top of the sketch a few different ways you can communicate with the Bluefruit LE: hardware serial,

software serial, hardware SPI and software SPI.

For the SPI Bluefruit, you cannot use serial. However, you can choose between hardware and software SPI.

If you want to use hardware SPI, uncomment this chunk of code (and comment out the other three options)

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */

Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);

If you want to use software/bitbang SPI, uncomment the following definition. You can then use any 6 pins (or 5, if you dont want to use RST)

/* ...software SPI, using SCK/MOSI/MISO user-defined SPI pins and then user selected CS/IRQ/RST */

Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_SCK, BLUEFRUIT_SPI_MISO,

                             BLUEFRUIT_SPI_MOSI, BLUEFRUIT_SPI_CS,

                             BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);
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Software

In order to try out our demos, you'll need to download the Adafruit BLE library for the nRF51 based modules such as this one (a.k.a.

Adafruit_BluefruitLE_nRF51)

You can check out the code here at github, (http://adafru.it/f4V) but its likely easier to just download by clicking:

Download Adafruit_BluefruitLE_nRF51

http://adafru.it/f4W

Rename the uncompressed folder Adafruit_BluefruitLE_nRF51 and check that the Adafruit_BluefruitLE_nRF51 folder contains

Adafruit_BLE.cpp and Adafruit_BLE.h (as well as a bunch of other files)

Place the Adafruit_BluefruitLE_nRF51 library folder your arduinosketchfolder/libraries/ folder. 

You may need to create the libraries subfolder if its your first library. Restart the IDE.

We also have a great tutorial on Arduino library installation at:

http://learn.adafruit.com/adafruit-all-about-arduino-libraries-install-use (http://adafru.it/aYM)

After restarting, check that you see the library folder with examples:
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Configuration!

Before you start uploading any of the example sketches, you'll need to CONFIGURE the Bluefruit interface - there's a lot of options so pay close

attention!

Which board do you have?

There's a few products under the Bluefruit name:

If you are using the Bluefruit LE Shield then you have an SPI-connected NRF51822

module. You can use this with Atmega328 (Arduino UNO or compatible), ATmega32u4

(Arduino Leonardo, compatible) or ATSAMD21 (Arduino Zero, compatible) and possibly

others. 

Your pinouts are Hardware SPI, CS = 8, IRQ = 7, RST = 4

Bluefruit Micro or Feather 32u4 Bluefruit

If you have a Bluefruit Micro or Feather 32u4 Bluefruit LE then you have an

ATmega32u4 chip with Hardware SPI, CS = 8, IRQ = 7, RST = 4

Feather M0 Bluefruit LE

If you have a Feather M0 Bluefruit LE then you have an ATSAMD21 chip with Hardware

SPI, CS = 8, IRQ = 7, RST = 4
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Bluefruit LE SPI Friend

If you have a stand-alone module, you have a bit of flexibility with wiring however we

strongly recommend Hardware SPI, CS = 8, IRQ = 7, RST = 4

You can use this with just about any microcontroller with 5 or 6 pins

Bluefruit LE UART Friend or Flora BLE

If you have a stand-alone UART module you have some flexibility with wiring. However

we suggest hardware UART if possible. You will likely need to use the flow control CTS

pin if you are not using hardware UART. There's also a MODE pin

You can use this with just about any microcontroller with at least 3 pins, but best used

with a Hardware Serial/UART capable chip!

Configure the Pins Used

You'll want to check the Bluefruit Config to set up the pins you'll be using for UART or SPI

Each example sketch has a secondary tab with configuration details. You'll want to edit and save the sketch to your own documents folder once

set up.
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Common settings:

You can set up how much RAM to set aside for a communication buffer and whether you want to have full debug output. Debug output is 'noisy' on

the serial console but is handy since you can see all communication between the micro and the BLE

// ----------------------------------------------------------------------------------------------

// These settings are used in both SW UART, HW UART and SPI mode

// ----------------------------------------------------------------------------------------------

#define BUFSIZE                        128   // Size of the read buffer for incoming data

#define VERBOSE_MODE                   true  // If set to 'true' enables debug output

Software UART

If you are using Software UART, you can set up which pins are going to be used for RX, TX, and CTS flow control. Some microcontrollers are

limited on which pins can be used! Check the SoftwareSerial library documentation for more details

// SOFTWARE UART SETTINGS

#define BLUEFRUIT_SWUART_RXD_PIN       9    // Required for software serial!

#define BLUEFRUIT_SWUART_TXD_PIN       10   // Required for software serial!

#define BLUEFRUIT_UART_CTS_PIN         11   // Required for software serial!

#define BLUEFRUIT_UART_RTS_PIN         -1   // Optional, set to -1 if unused

Hardware UART

If you have Hardware Serial, there's a 'name' for it, usually Serial1 - you can set that up here:

// HARDWARE UART SETTINGS

#ifdef Serial1    // this makes it not complain on compilation if there's no Serial1

  #define BLUEFRUIT_HWSERIAL_NAME      Serial1

#endif

Mode Pin

For both hardware and software serial, you will likely want to define the MODE pin. There's a few sketches that dont use it, instead depending on

commands to set/unset the mode. Its best to use the MODE pin if you have a GPIO to spare!

#define BLUEFRUIT_UART_MODE_PIN        12    // Set to -1 if unused

SPI Pins

For both Hardware and Software SPI, you'll want to set the CS (chip select) line, IRQ (interrupt request) line and if you have a pin to spare, RST

(Reset)

// SHARED SPI SETTINGS

#define BLUEFRUIT_SPI_CS               8

#define BLUEFRUIT_SPI_IRQ              7

#define BLUEFRUIT_SPI_RST              4    // Optional but recommended, set to -1 if unused

Software SPI Pins

If you don't have a hardware SPI port available, you can use any three pins...its a tad slower but very flexible

// SOFTWARE SPI SETTINGS

#define BLUEFRUIT_SPI_SCK              13

#define BLUEFRUIT_SPI_MISO             12

#define BLUEFRUIT_SPI_MOSI             11

Refer to the table above to determine whether you have SPI or UART controlled Bluefruits!

Select the Serial Bus

Once you've configured your pin setup in the BluefruitConfig.h file, you can now check and adapt the example sketch.

The Adafruit_BluefruitLE_nRF51 library supports four different serial bus options, depending on the HW you are using: SPI both hardware and

software type, and UART both hardware and software type.

UART Based Boards (Bluefruit LE UART Friend & Flora BLE)

This is for Bluefruit LE UART Friend & Flora BLE boards. You can use either software serial or hardware serial. Hardware serial is higher quality,

and less risky with respect to losing data. However, you may not have hardware serial available! Software serial does work just fine with flow-

© Adafruit Industries
https://learn.adafruit.com/introducing-the-adafruit-bluefruit-spi-

breakout
Page 20 of 110



control and we do have that available at the cost of a single GPIO pin.

For software serial (Arduino Uno, Adafruit Metro) you should uncomment the software serial contructor below, and make sure the other three

options (hardware serial & SPI) are commented out.

// Create the bluefruit object, either software serial...uncomment these lines

SoftwareSerial bluefruitSS = SoftwareSerial(BLUEFRUIT_SWUART_TXD_PIN, BLUEFRUIT_SWUART_RXD_PIN);

Adafruit_BluefruitLE_UART ble(bluefruitSS, BLUEFRUIT_UART_MODE_PIN,

                      BLUEFRUIT_UART_CTS_PIN, BLUEFRUIT_UART_RTS_PIN);

For boards that require hardware serial (Adafruit Flora, etc.), uncomment the hardware serial constructor, and make sure the other three options

are commented out

/* ...or hardware serial, which does not need the RTS/CTS pins. Uncomment this line */

Adafruit_BluefruitLE_UART ble(BLUEFRUIT_HWSERIAL_NAME, BLUEFRUIT_UART_MODE_PIN);

SPI Based Boards (Bluefruit LE SPI Friend)

For SPI based boards, you should uncomment the hardware SPI constructor below, making sure the other constructors are commented out:

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */

Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);

If for some reason you can't use HW SPI, you can switch to software mode to bit-bang the SPI transfers via the following constructor:

/* ...software SPI, using SCK/MOSI/MISO user-defined SPI pins and then user selected CS/IRQ/RST */

Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_SCK, BLUEFRUIT_SPI_MISO,

                             BLUEFRUIT_SPI_MOSI, BLUEFRUIT_SPI_CS,

                             BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);
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ATCommand

The ATCommand example allows you to execute AT commands from your sketch, and see the results in the Serial Monitor.  This can be useful

for debugging, or just testing different commands out to see how they work in the real world. It's a good one to start with!

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select atcommand:

This will open up a new instance of the example in the IDE, as shown below:

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:

This tutorial does not need to use the MODE pin, make sure you have the mode switch in CMD mode if you do not configure & connect a
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MODE pin

Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it! (The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor

via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to 115200:

To send an AT command to the Bluefruit LE module, enter the command in the textbox at the top of the Serial Monitor and click the Send button:

The response to the AT command will be displayed in the main part of the Serial Monitor. The response from 'ATI' is shown below:
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You can do pretty much anything at this prompt, with the AT command set. Try AT+HELP to get a list of all commands, and try out ones like

AT+HWGETDIETEMP (get temperature at the nRF51822 die) and AT+HWRANDOM (generate a random number)
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BLEUart

The BLEUart example sketch allows you to send and receive text data between the Arduino and a connected Bluetooth Low Energy Central

device on the other end (such as you mobile phone using the Adafruit Bluefruit LE Connect application for Android (http://adafru.it/f4G) or

iOS (http://adafru.it/f4H) in UART mode).

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select

bleuart_cmdmode:

This will open up a new instance of the example in the IDE, as shown below:

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI
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